Βασικές οδηγίες επεξεργασίας κειμένων ΕΕΠΦ

Είσοδος στο διαχειριστικό της ιστοσελίδας

Για την είσοδο σας στο διαχειριστικό της σελίδας, πληκτρολογείτε το παρακάτω url: http://www.eepf.gr/administrator
Συμπληρώνετε τους εξής κωδικούς 2 φορές:
Username: eepf
Password: @ee@pf2k!19
Και πατήστε Log In για να συνδεθείτε. Πλέον βρίσκεστε στο διαχειριστικό της ιστοσελίδας.

Μορφοποίηση κειμένων της ιστοσελίδας
Για να κάνετε αλλαγές στα κείμενα της ιστοσελίδας, επιλέγετε από το Menu στο πάνω μέρος της σελίδας την επιλογή Content και μετά την επιλογή Articles.
Σχεδόν όλες οι εσωτερικές σελίδες είναι και ένα Article. (π.χ. η σελίδα «Η ιστορία μας» είναι ένα article, οπότε μπορείτε να κάνετε αντιγραφή τον τίτλο «Η ιστορία μας», να πάτε στα άρθρα και στο πεδίο search να κάνετε επικόλληση. Έτσι θα βρείτε εύκολα και γρήγορα το άρθρο που απεικονίζεται σε αυτή τη σελίδα ώστε να το επεξεργαστείτε)
Για να βρείτε το κείμενο που σας ενδιαφέρει, μπορείτε 
· Είτε να το ψάξετε ένα προς ένα μέχρι να βρείτε αυτό που σας ενδιαφέρει
· Είτε να βρείτε τα άρθρα που ανήκουν σε κάθε tag (όπως φαίνονται στην ιστοσελίδα, πχ Δράσεις Προστασίας, Γαλάζια Σημαία, Green Key κλπ.). Για να το κάνετε αυτό, επιλέγετε το κουμπί “Search Tools” που βρίσκεται δίπλα από το πεδίο αναζήτησης, κάτω από το δεύτερο οριζόντιο μενού. 
· Αφού επιλέξετε το Search Tools, σας εμφανίζονται διάφορες επιλογές. Μπορείτε να επιλέξετε και το - Select Tag - και σας εμφανίζεται μία drop-down λίστα όλων των tag της ιστοσελίδας. Από αυτά μπορείτε να επιλέξετε ένα tag και έτσι εμφανίζονται μόνο τα άρθρα που ανήκουν στο συγκεκριμένο tag. 

Μόλις επιλέξετε το tag που σας ενδιαφέρει, θα σας εμφανιστούν όλα τα Άρθρα που εμφανίζονται στην σελίδα Blue Flag , Γαλάζια Σημαία, Νέοι Δημοσιογράφοι κλπ. Πχ σύμφωνα με το προηγούμενο παράδειγμα όπου επιλέξαμε το tag Blue Flag, θα μας εμφανιστούν 3 Άρθρα που αντιστοιχούν στη σελίδα Blue Flag της ιστοσελίδας. Τέλος επιλέγετε το Άρθρο που θέλετε να τροποποιήσετε.
· Είτε να βρείτε τα άρθρα που ανήκουν στις εκάστοτε κατηγορίες (όπως φαίνονται στην ιστοσελίδα, πχ Νέα). Για να το κάνετε αυτό, επιλέγετε το κουμπί “Search Tools” που βρίσκεται δίπλα από το πεδίο αναζήτησης, κάτω από το δεύτερο οριζόντιο μενού. 

Αφού επιλέξετε το Search Tools, σας εμφανίζονται διάφορες επιλογές. Εσείς επιλέγετε το - Select Category - και σας εμφανίζεται μία drop-down λίστα όλων των κατηγοριών της ιστοσελίδας. Από αυτές μπορείτε να επιλέξετε σε ποια θέλετε να αλλάξετε τα κείμενα (πχ Νέα). 

Μόλις επιλέξετε την κατηγορία που σας ενδιαφέρει, θα σας εμφανιστούν όλα τα Άρθρα που εμφανίζονται στην κατηγορία κανονικά στην ιστοσελίδα. Πχ σύμφωνα με το προηγούμενο παράδειγμα όπου επιλέξαμε την κατηγορία Νέα, θα μας εμφανιστούν όλα τα Άρθρα που αντιστοιχούν στο μενού Νέα της ιστοσελίδας. Τέλος επιλέγετε το Άρθρο που θέλετε να τροποποιήσετε.

Για την τροποποίηση των Άρθρων ισχύουν τα εξής:
Με το που «μπείτε» στη διαχείριση ενός Άρθρου θα σας εμφανιστούν κάποια πεδία.
· Όπου Title ο τίτλος του Άρθρου. Αυτό το πεδίο μπορείτε να το αλλάξετε
· Όπου alias είναι η ακολουθία χαρακτήρων όπου εμφανίζεται στην ιστοσελίδα. Αυτό το πεδίο δεν πρέπει να το αλλάξετε (εκτός αν δημιουργείτε το άρθρο) γιατί το έχουν κάνει index οι μηχανές αναζήτησης.
· Το πεδίο Status όπου υποδεικνύει αν το άρθρο είναι published (δημοσιοποιημένο στη σελίδα) και αν επιθυμείτε μπορείτε να το αλλάξετε σε unpublished και έτσι το άρθρο θα απενεργοποιηθεί και δεν θα μπορεί κανένας χρήστης να το δει μπροστά στη σελίδα, παρά μόνο πίσω στο διαχειριστικό του Joomla, αυτό μπορείτε να το κάνετε σε περίπτωση που θέλετε να το κρύψετε για την ώρα και δεν θέλετε να το διαγράψετε γιατί μπορεί στο μέλλον να το ξανά χρησιμοποιήσετε. Συνεπώς έτσι το γυρνάτε στο unpublished και μετά πάλι στο published. Επίσης υπάρχει το πεδίο Category το οποίο υποδεικνύει την κατηγορία στην οποία ανήκει αυτό το Άρθρο, σε αυτό το πεδίο αν το άρθρο είναι για την ελληνική version του site τότε θα επιλέγετε την κατηγορία Νέα για να δείξει το άρθρο στο Μενού Νέα της σελίδας αν το άρθρο είναι για την αγγλική version τότε θα επιλέγετε την κατηγορία News, αυτά τα βήματα θα πραγματοποιείτε μόνο όταν θέλετε το άρθρο να μπει στο Μενού Νέα ή News, αν δεν θέλετε τότε δηλώστε το στη κατηγορία Uncategorized. Το πεδίο Language υποδεικνύει σε ποια γλώσσα θα είναι το συγκεκριμένο άρθρο, καλό θα ήταν αν αυτό το άρθρο πρόκειται να γραφτεί στα ελληνικά να επιλέγετε την ελληνική γλώσσα κλπ. Τέλος θα βρείτε και το πεδίο Tags, εκεί κλικάρωντας απλά στο λευκό πεδίο εμφανίζονται όλα τα Tags που έχετε δημιουργήσει, μπορείτε να επιλέξετε όσα Tags επιθυμείτε και έτσι το άρθρο θα πάει στη κατάλληλη σελίδα (Blue Flag , Γαλάζια Σημαία, Νέοι Δημοσιογράφοι κλπ.). Αν το άρθρο θέλετε να πάει μόνο στη σελίδα Νέα δεν χρειάζεται να βάλετε Tag, αν όμως το άρθρο επιθυμείτε να πάει και στη σελίδα Νέα αλλά και στη σελίδα π.χ. Γαλάζια Σημαία τότε εκτός από το πεδίο Category που θα επιλέξετε την επιλογή Νέα, στο πλαίσιο με τα Tags θα επιλέξετε και το Γαλάζια Σημαία ώστε να τοποθετηθεί το άρθρο και στη σελίδα της Γαλάζιας Σημαίας όπου απεικονίζει όλα τα σχετικά άρθρα με αυτό το Tag. 
· Τέλος, το κεντρικό μέρος της σελίδας καταλαμβάνεται από ένα πεδίο μέσα στο οποίο είναι περασμένο το κείμενο του Άρθρου. Αυτό το πεδίο περιέχει στο εσωτερικό του και εντολές οι οποίες προσομοιάζουν τις εντολές μορφοποίησης κειμένου του Word. Συνεπώς, μπορείτε να μορφοποιήσετε το κείμενο σας κατά βούληση με βάση αυτές τις εντολές (πχ να κάνετε κάποιο σημείο bold ή italics, να βάλετε κείμενο σε λίστα με bullets κοκ).
· Επίσης, σε αυτό το πεδίο μπορείτε να προσθέσετε και νέο κείμενο, πάλι με τον ίδιο τρόπο με τον οποίο προστίθεται κείμενο σε ένα αρχείο Word (νέα παράγραφος με Enter, κοκ)
· ΠΡΟΣΟΧΗ – Ανάμεσα στις εντολές που υπάρχουν είναι και η εντολή [image: C:\Users\aris\Desktop\Capture.PNG] , όταν πατηθεί αυτή η εντολή εμφανίζεται στο κείμενο μία μαύρη οριζόντια  γραμμή, αυτό σημαίνει πως από την γραμμή και κάτω το κείμενο θα είναι κρυφό και θα εμφανιστεί μόνο όταν ο χρήστης πατήσει στον τίτλο του άρθρο ή στο κουμπί ΠΕΡΙΣΣΟΤΕΡΑ… ώστε να μπει μέσα στο άρθρο, εκεί θα μπορεί να δει κανονικά όλο το κείμενο. Πχ έχουμε το άρθρο «Νέοι Δημοσιογράφοι για το Περιβάλλον", ένας μαθητής μεταφέρει την εμπειρία που αποκόμισε στη Διεθνή Αποστολή του Προγράμματος στην Πορτογαλία το 2019 Νέοι Δημοσιογράφοι», και δεν θέλουμε να δείξουμε όλη την πληροφορία που περιέχει στον χρήστη πριν μπει μέσα στη σελίδα του άρθρου πάρα μόνο την πρώτη παράγραφο, όπως δηλαδή φαίνονται όλα τα άρθρα στη σελίδα Νέα, μόνο ένα μικρό εισαγωγικό κείμενο. Για να γίνει αυτό βρίσκουμε το άρθρο με τον παραπάνω τίτλο πίσω στο διαχειριστικό και μέσα στο πλαίσιο που περιέχει το κείμενο του άρθρου, κάνουμε κλικ με τον κέρσορα στο σημείο που θέλουμε να μπει η οριζόντια γραμμή και πατάμε το [image: C:\Users\aris\Desktop\Capture.PNG].

Όλα τα παραπάνω αναφέρθηκαν στον τρόπο με τον οποίο μορφοποιείται το κείμενο ενός Άρθρου. Σε περίπτωση που θέλετε να αλλάξετε τις φωτογραφίες του Άρθρου, εκτελείτε τα εξής:
· Κάτω από το πεδίο του Title, υπάρχουν κάποιες επιλογές. Αυτή τη στιγμή εσείς βρίσκεστε στο tab Content. Επιλέξτε το tab Images and Links.
· Τα πεδία που μας ενδιαφέρουν είναι στα αριστερά της σελίδας, και συγκεκριμένα το πεδίο Intro Image και Full Article Image. Η Intro Image είναι η εικόνα που εμφανίζεται στην προβολή όλων των άρθρων μιας κατηγορίας, ενώ η Full Article Image είναι η εικόνα που εμφανίζεται στις εσωτερικές πληροφορίες κάθε Άρθρου μιας κατηγορίας, σε κάθε περίπτωση όποια φωτογραφία επιλέξατε στο ένα πεδίο την ίδια φωτογραφία θα επιλέξετε και στο άλλο. 
· Οι προτεινόμενες διαστάσεις των εικόνων πρέπει να είναι τουλάχιστον 847x465 pixels. Για να αλλάξετε την εικόνα, στο πεδίο δίπλα από το Intro Image επιλέγετε το κουμπί με την ένδειξη Select και σας ανοίγει ένα νέο παράθυρο. Σε αυτό θα πρέπει να φορτώσετε τη νέα φωτογραφία που θέλετε να προσθέσετε.
· Στο νέο αυτό παράθυρο κάνετε scroll down και επιλέγετε το κουμπί με την ένδειξη «Επιλογή Αρχείων». Έτσι θα μπορέσετε να επιλέξετε την εικόνα που θέλετε να ανεβάσετε από τον υπολογιστή σας. Μόλις την επιλέξετε, πατήστε το κουμπί με την ένδειξη «Start Upload». Μόλις ανανεωθεί η σελίδα, η νέα φωτογραφία πλέον θα εμφανίζεται μαζί με τις άλλες. Την επιλέγετε και πατάτε το κουμπί με την ένδειξη “Insert”, ώστε να προστεθεί η νέα εικόνα στο πεδίο Intro Image.
· Όμοια προσθέτετε και την εικόνα στο πεδίο Full Article Image.

Για να αποθηκεύσετε τις αλλαγές σας, πατήστε το κουμπί Save στο πάνω μέρος της σελίδας, και για να κλείσετε το Άρθρο που δουλεύετε πατήστε το κουμπί Close. Σε περίπτωση που δε θέλετε να αποθηκευτούν οι αλλαγές σας, αντί για Close πατήστε Cancel.

Προσθήκη Εκδρομής στο Πρόγραμμα Εκδρομών και έπειτα στο Αρχείο Εκδρομών
Ορισμένες σελίδες της ιστοσελίδας όπως τα Νέα ή τα News δείχνουν άρθρα , δηλαδή τα άρθρα που δείχνουν υπάγονται στην κατηγορία Νέα ή News που έχουμε φτιάξει.
Το ίδιο ακριβώς συμβαίνει και στις σελίδες Πρόγραμμα εκδρομών και Αρχείο εκδρομών. Οι δύο αυτές σελίδες φέρνουν άρθρα που ανήκουν στις 2 αυτές κατηγορίες που έχουμε φτιάξει, οπότε όταν μία εκδρομή θέλουμε να την δείξουμε στη σελίδα Πρόγραμμα εκδρομών τότε το άρθρο της εκδρομής αυτής το δηλώνουμε στην κατηγορία Πρόγραμμα εκδρομών (μπαίνουμε στο διαχειριστικό και μέσα στην επεξεργασία του άρθρου στα δεξιά εκεί που λέει Category επιλέγουμε το βελάκι ανοίγει το dropdown με όλες τις κατηγορίες του site και έτσι επιλέγουμε την κατηγορία Πρόγραμμα εκδρομών) για να το δείξει μπροστά στη σελίδα, αν τώρα το άρθρο αυτό θέλουμε να το βγάλουμε από το Πρόγραμμα εκδρομών και να το βάλουμε στο Αρχείο εκδρομών το μόνο που έχουμε να κάνουμε είναι να του αλλάξουμε κατηγορία και να το δηλώσουμε στη κατηγορία Αρχείο εκδρομών, ώστε να το δείξει μπροστά στη σελίδα Αρχείο εκδρομών.

Widgekit
Για να κάνετε αλλαγές σε διάφορα πρόσθετα που εμφανίζονται μέσα σε άρθρα της ιστοσελίδας ή σε διάφορα modules, επιλέγετε από το πρώτο Menu στο πάνω μέρος της σελίδας την επιλογή Components και μετά την επιλογή Widgetkit. Από εκεί μπορείτε να προσθαφαιρείτε φωτογραφίες στα διάφορα widgets που έχουν δημιουργηθεί.
[bookmark: _Hlk9928181]Όπως θα παρατηρήσετε μπαίνοντας στο διαχειριστικό του Joomla θα δείτε διάφορα κουτάκια που πατώντας τα σας ανακατευθύνουν μέσα σε άρθρα, modules, μενού, sliders και widgetkits, επίσης θα δείτε ότι σε κάποια κουτάκια αναγράφεται το μήνυμα [widgetkit id="75"]. Καθώς επιλέγετε από το πρώτο Menu στο πάνω μέρος της σελίδας την επιλογή Components και μετά την επιλογή Widgetkit θα σας μεταφέρει στη σελίδα που περιέχει όλα τα widgetkits που έχουν δημιουργηθεί, εκεί θα δείτε πως στα αριστερά αναγράφεται ο τίτλος του Widgetkit που δε χρησιμοποιείται πουθενά, απλώς είναι για να μας βοηθάει εμάς πιο πολύ στην αρχειοθέτηση και αρκετά δεξιά από τον τίτλο βρίσκεται είναι η ονομασία του είδους του κάθε Widgetkit (δηλαδή Grid,List,Grid Stack, Gallery, Slideset) και το id του κάθε Widgetkit ([widgetkit id="75]), οπότε γνωρίζοντας το id του Widgetkit που θέλετε να επεξεργαστείτε μπαίνετε στη σελίδα που βρίσκονται όλα τα widgetkits και απλά το αναζητάτε όταν το βρείτε πατάτε πάνω και σας μεταφέρει μέσα στο συγκεκριμένο Widgetkit που θέλετε να επεξεργαστείτε. Επίσης όταν δημιουργείτε ένα νέο Widgetkit αυτό παίρνει ένα καινούργιο id ([widgetkit id="XX]), για να το εισάγετε μέσα σε ένα άρθρο αντιγράφετε όλο το λεκτικό με τις αγκύλες [widgetkit id="XX"], μπαίνετε στο άρθρο και το κάνετε επικόλληση μέσα στη πεδίο που γράφουμε την περιγραφή του άρθρου.
Για τις ανάγκες τις Ιστοσελίδας έχουν χρησιμοποιηθεί 5 διαφορετικά είδη Widgetkit, τα οποία είναι τα εξής:
· Grid
· Το Grid Widgetkit δημιουργεί κουτάκια και τα δείχνει σε τριάδες, δυάδες, εξάδες ανάλογα την επιλογή που έχουμε επιλέξει και έχει χρησιμοποιηθεί στις σελίδες Green Key, Γαλάζια Σημαία, Οικολογικά Σχολεία, Eco Schools Network, Blue Flag κλπ. και είναι τα κουτάκια που βρίσκονται κάτω από το εισαγωγικό κείμενο τις κάθε σελίδας.
· List
· Το List Widgetkit έχει χρησιμοποιηθεί στις σελίδες Green Key, Γαλάζια Σημαία, Οικολογικά Σχολεία, Eco Schools Network, Blue Flag κλπ.
Το συγκεκριμένο Widgetkit έχει τοποθετηθεί στα δεξιά κάθε εισαγωγικού κειμένου (Green Key, Γαλάζια Σημαία, Οικολογικά Σχολεία, Eco Schools Network, Blue Flag κλπ.) και απεικονίζει την εικόνα και τον τίτλο του αντικειμένου και έχει συνδεθεί με link και σε πάει μέσα στο άρθρο που έχει δημιουργηθεί είτε σε εξωτερικό σύνδεσμο.
· Grid Stack
· Το Grid Stack Widgetkit έχει χρησιμοποιηθεί στις σελίδες Στελέχη|Εθελοντές|Διοικητικό Συμβούλιο και Volunteers|Executives|Board of Directors.
Το συγκεκριμένο Widgetkit απεικονίζει, το υλικό που θα το βάλετε όπως στις παραπάνω σελίδες, δηλαδή εικόνα στα αριστερά, κείμενο στα δεξιά και κάθε φορά που προστίθεται κάτι θα το δείχνει πάντα με την αντίθετη φορά του προηγούμενου.
· Gallery
· Το Gallery Widgetkit δείχνει μόνο εικόνες όπως θα δείτε σε κάποια άρθρα που ανήκουν στην κατηγορία Galleries όπως π.χ. το άρθρο «Εκδήλωση Βράβευσης & Έκθεση μεταλλικών αντικειμένων, Ωδείο Αθηνών»
· Slideset
· Το Slideset Widgetkit έχει δημιουργηθεί μόνο 2 φορές και υπάρχει στην αρχική σελίδα του ελληνικού και του αγγλικού version και απεικονίζει τα λογότυπα όλων των χορηγών.
Προσοχή: Όλα τα παραπάνω Widgetkit που έχουμε δημιουργήσει περιέχουν κάποιες ρυθμίσεις διότι έπρεπε να προσαρμοστούν στις ανάγκες του site, αν δημιουργήστε ένα καινούργιο Widgetkit και ας είναι το ίδιο είδος με ένα από τα παραπάνω δε σημαίνει πως θα το δείχνει όπως και αυτά που έχουν είδη δημιουργηθεί διότι πατώντας στη δημιουργία ενός νέου όλες οι ρυθμίσεις είναι default και μετά τις προσαρμόζετε ανάλογα. Οπότε σε αυτό το σημείο καλό θα ήταν να μην δημιουργείτε ένα καινούργιο αλλά να αντιγράφετε ένα που υπάρχει ήδη και απλά να αντικαταστείτε το περιεχόμενό του. Για να αντιγράψετε ένα Widgetkit πηγαίνετε τον κέρσορα πάνω από το όνομα του Widgetkit που επιθυμείτε ώσπου να κιτρινίσει όλο το Widgetkit εκεί θα δείτε, ότι δεξιά από το id εμφανίστηκαν δύο σύμβολα το αριστερά είναι για να κάνει το συγκεκριμένο Widgetkit copy και πατώντας το να δημιουργηθεί ένα αντίγραφό του ακριβώς από κάτω με τις ίδιες ρυθμίσεις και το δεξιά εικονίδιο είναι για το διαγράψει μόνιμα.
[image: C:\Users\aris\Desktop\Capture.PNG] 

Αντιγραφή και επεξεργασία καινούργιου Grid Widgetkit 
Αφού λοιπόν έχετε κάνει αντιγραφή του Widgetkit που επιθυμείτε όπως αναφέρετε παραπάνω πατάτε στο αντίγραφο που δημιούργησε και μεταφέρεστε μέσα στο Widgetkit. Καλό θα ήταν να μετονομάσετε το Widgetkit με ένα ενδεικτικό όνομα ώστε να σας βοηθήσει μετά στην αναζήτηση. Π.χ. πατήστε copy στο Board of Directors 2018, από κάτω ακριβώς θα δημιουργήσει το αντίγραφό του με όνομα Board of Directors 2018 (copy), πατάτε πάνω του και εκεί που αναγράφει το όνομα Board of Directors 2018 (copy) το σβήνετε και γράφετε Board of Directors 2019
· TITLE: Ο τίτλος που θα εμφανίζεται πάνω από το κείμενο
· Media: Η εικόνα που δείχνει μέσα στο κουτάκι. Επιλέγετε το κουμπί select και στο παράθυρο που εμφανίζετε είτε επιλέγετε μια φωτογραφία είτε σέρνετε μια νέα και αφού την ανεβάσει την επιλέγετε ώστε να αντικαταστήσει την ήδη υπάρχουσα.
· CONTENT: Το αφήνετε κενό, όμως αν θέλετε μπορείτε να γράψετε κάποιο περιεχόμενο, θα εμφανιστεί κάτω από την εικόνα.
· LINK: Κάνουμε paste έναν εξωτερικό σύνδεσμο που έχουμε αποθηκεύσει π.χ. http://www.blueflag.gr/odigies-organosis-aktis και θέλουμε πατώντας το κουτί να σε πηγαίνει εκεί είτε το link που έχουμε δημιουργήσει βάζοντας μπροστά το πρόθεμα el/ ή en/ ανάλογα σε ποια γλώσσα έχει γραφτεί το άρθρο που δημιουργήσαμε το link. Παρακάτω εξηγείτε η διαδικασία και τα βήματα δημιουργίας link
· Αν τώρα θέλετε να το κάνετε link με ένα άρθρο που έχετε δημιουργήσει, ακολουθείτε την εξής διαδικασία. Αφού έχετε δημιουργήσει ένα καινούργιο άρθρο πρέπει και να δημιουργήσετε το link του άρθρου, από το πάνω Menu, πατάτε ΔΗΜΙΟΥΡΓΑ LINK και επιλέγετε το πράσινο κουμπί New που βρίσκετε κάτω από το Menu, στη συνέχεια συμπληρώνετε τα πεδία:
· Menu Title: Ο τίτλος να είναι ίδιος με αυτόν του άρθρου
· Menu Item Type: Πατάτε το κουμπί Select->Articles->Single Article
· Select Article: Πατάτε το κουμπί Select και επιλέγετε το άρθρο που θέλετε να κάνετε link
Και πατάτε Save, τώρα στο πεδίο Alias που είναι δίπλα στο Menu Title, έχει γράψει το όνομα του link άρθρου με μικρά γράμματα και έχει αντικαταστήσει το κενό με παύλες, κάνουμε αντιγραφή όλο το περιεχόμενο που έχει προστεθεί σε αυτό το πλαίσιο και πάμε πίσω στο Widgetkit και πάμε στο αντικείμενο που θέλουμε να το κάνουμε link και μέσα στο πλαίσιο κάνουμε paste το Alias που πήραμε από το link που δημιουργήσαμε προηγουμένως και μπροστά θα προσθέσουμε το πρόθεμα el/ αν είναι για την ελληνική γλώσσα ενώ το en/ αν είναι για την αγγλική. Πχ έχουμε δημιουργήσει το άρθρο “Το Διοικητικό Συμβούλιο”, πατάμε στο πάνω Menu Δημιουργία Link και το πράσινο κουμπί New. Στο Menu Title γράφω “Το Διοικητικό Συμβούλιο”, στο Menu Item Type πατάω το Select->Articles->Single Article και στο Select Article επιλέγω το άρθρο με την ονομασία “Το Διοικητικό Συμβούλιο” πατάω Save και τώρα στο πλαίσιο Alias έχει γράψει από μόνο του τον τίτλο με μικρά γράμματα και παύλες  ως εξής «το-διοικητικό-συμβούλιο», κάνουμε αντιγραφεί αυτού του κειμένου πάμε στα widgetkits και επιλέγουμε το List Widgetkit που έχουμε δημιουργήσει και μπαίνουμε μέσα, στη συνέχεια επιλέγουμε το αντικείμενο που θέλουμε να βάλουμε το link και στο πλαίσιο που βρίσκεται κάτω από το link εκεί μέσα θα γράψουμε το πρόθεμα el/ το-διοικητικό-συμβούλιο έτσι δημιουργήσαμε το link και μετά ο χρήστης πατώντας στο site στο συγκεκριμένο item θα μεταφερθεί στο άρθρο του Διοικητικού Συμβουλίου. Προσοχή η διαδικασία της δημιουργίας του link θα πραγματοποιείτε μόνο για τέτοιες περιπτώσεις που χρειάζεται να κάνουμε link ένα αντικείμενο.  Δεν σημαίνει πως όταν θα δημιουργούμε ένα νέο άρθρο πρέπει να πηγαίνουμε πάντα στο Δημιουργία Link και να το επιλέγουμε.
· Στα αριστερά δείχνει όλα τα αντικείμενα που έχουν δημιουργηθεί, μπορείτε να αλλάξετε τη σειρά τους, κλικάροντας τα με το αριστερό κλικ και το μεταφέρετε σε όποια θέση εσείς επιθυμείτε χωρίς να αφήσετε το αριστερό κλικ. Επίσης μπορείτε να δημιουργήσετε ένα καινούργιο αντικείμενο πατώντας από κάτω το κουμπάκι Add Item, έτσι δημιουργεί ένα άδειο αντικείμενο και το μόνο που έχετε να κάνετε είναι να προσθέσετε έναν τίτλο μία εικόνα και το κείμενο. Και τέλος πατάτε Save & Close

Αντιγραφή και επεξεργασία καινούργιου List Widgetkit 
Αφού έχετε κάνει αντιγραφή του Widgetkit που επιθυμείτε πατάτε στο αντίγραφο που δημιούργησε και μεταφέρεστε μέσα στο Widgetkit. Καλό θα ήταν να μετονομάσετε το Widgetkit με ένα ενδεικτικό όνομα ώστε να σας βοηθήσει μετά στην αναζήτηση. Π.χ. πατήστε copy στο Board of Directors 2018, από κάτω ακριβώς θα δημιουργήσει ένα αντίγραφό του με όνομα Board of Directors 2018 (copy), μπαίνετε μέσα και εκεί που αναγράφει το όνομα Board of Directors 2018 (copy) το σβήνετε και γράφετε Board of Directors 2019
· TITLE: Ο τίτλος που θα εμφανίζεται πάνω από το κείμενο
· Media: Η εικόνα που δείχνει είτε δεξιά είτε αριστερά ανάλογα πως είναι το προηγούμενο. Επιλέγετε το κουμπί select και στο παράθυρο που εμφανίστηκε είτε επιλέγετε μια φωτογραφία είτε σέρνετε μια νέα και αφού την ανεβάσει την επιλέγετε ώστε να αντικαταστήσει τη ήδη υπάρχουσα
· CONTENT: Το αφήνετε κενό 
· LINK: Εδώ μιας και το List Widgetkit έχει χρησιμοποιηθεί για κάθε εισαγωγικό κείμενο (Green Key, Γαλάζια Σημαία, Οικολογικά Σχολεία, Eco Schools Network, Blue Flag κλπ.) πρέπει να μπει το link που θέλετε να πηγαίνει το κάθε αντικείμενο κλικάροντάς το. Είτε λοιπόν μπορείτε να βάλετε έναν εξωτερικό σύνδεσμο πχ παίρνετε copy ένα link(www.google.com) και το κάνετε paste μέσα στο πλαίσιο του link, έτσι το αντικείμενο θα γίνει link. Αν τώρα θέλετε να το κάνετε link με ένα άρθρο που έχετε δημιουργήσει, ακολουθείτε την εξής διαδικασία. Αφού έχετε δημιουργήσει ένα καινούργιο άρθρο πρέπει και να δημιουργήσετε το link του άρθρου, από το πάνω Menu, πατάτε ΔΗΜΙΟΥΡΓΑ LINK και επιλέγετε το πράσινο κουμπί New που βρίσκετε κάτω από το Menu, στη συνέχεια συμπληρώνετε τα πεδία:
· Menu Title: Ο τίτλος να είναι ίδιος με αυτόν του άρθρου
· Menu Item Type: Πατάτε το κουμπί Select->Articles->Single Article
· Select Article: Πατάτε το κουμπί Select και επιλέγετε το άρθρο που θέλετε να κάνετε link
· Και πατάτε Save, τώρα στο πεδίο Alias που είναι δίπλα στο Menu Title, έχει γράψει το όνομα του link άρθρου με μικρά γράμματα και έχει αντικαταστήσει το κενό με παύλες, κάνουμε αντιγραφή όλο το περιεχόμενο που έχει προστεθεί σε αυτό το πλαίσιο και πάμε πίσω στο Widgetkit και πάμε στο αντικείμενο που θέλουμε να το κάνουμε link και μέσα στο πλαίσιο κάνουμε paste το Alias που πήραμε από το link που δημιουργήσαμε προηγουμένως και μπροστά θα προσθέσουμε το πρόθεμα el/ αν είναι για την ελληνική γλώσσα ενώ το en/ αν είναι για την αγγλική. Πχ έχουμε δημιουργήσει το άρθρο “Το Διοικητικό Συμβούλιο”, πατάμε στο πάνω Menu Δημιουργία Link και το πράσινο κουμπί New. Στο Menu Title γράφω “Το Διοικητικό Συμβούλιο”, στο Menu Item Type πατάω το Select->Articles->Single Article και στο Select Article επιλέγω το άρθρο με την ονομασία “Το Διοικητικό Συμβούλιο” πατάω Save και τώρα στο πλαίσιο Alias έχει γράψει από μόνο του τον τίτλο με μικρά γράμματα και παύλες  ως εξής «το-διοικητικό-συμβούλιο», κάνουμε αντιγραφεί αυτού του κειμένου πάμε στα widgetkits και επιλέγουμε το List Widgetkit που έχουμε δημιουργήσει και μπαίνουμε μέσα, στη συνέχεια επιλέγουμε το αντικείμενο που θέλουμε να βάλουμε το link και στο πλαίσιο που βρίσκεται κάτω από το link εκεί μέσα θα γράψουμε το πρόθεμα el/ το-διοικητικό-συμβούλιο έτσι δημιουργήσαμε το link και μετά ο χρήστης πατώντας στο site στο συγκεκριμένο item θα μεταφερθεί στο άρθρο του Διοικητικού Συμβουλίου. Προσοχή η διαδικασία της δημιουργίας του link θα πραγματοποιείτε μόνο για τέτοιες περιπτώσης που χρειάζεται να κάνουμε link ένα αντικείμενο. Δεν σημαίνει πως όταν θα δημιουργούμε ένα νέο άρθρο πρέπει να πηγαίνουμε πάντα στο Δημιουργία Link και να το επιλέγουμε.
Αντιγραφή και επεξεργασία καινούργιου Grid Stack Widgetkit 
Αφού έχετε κάνει αντιγραφή του Widgetkit που επιθυμείτε πατάτε στο αντίγραφο που δημιούργησε και μεταφέρεστε μέσα στο Widgetkit. Καλό θα ήταν να μετονομάσετε το Widgetkit με ένα ενδεικτικό όνομα ώστε να σας βοηθήσει μετά στην αναζήτηση. Π.χ. πατήστε copy στο Board of Directors 2018, από κάτω ακριβώς θα δημιουργήσει ένα αντίγραφό του με όνομα Board of Directors 2018 (copy), μπαίνετε μέσα και εκεί που αναγράφει το όνομα Board of Directors 2018 (copy) το σβήνετε και γράφετε Board of Directors 2019
· TITLE: Ο τίτλος που θα εμφανίζεται πάνω από το κείμενο
· Media: Η εικόνα που δείχνει είτε δεξιά είτε αριστερά ανάλογα πως είναι το προηγούμενο. Επιλέγετε το κουμπί select και στο παράθυρο που εμφανίστηκε είτε επιλέγετε μια φωτογραφία είτε σέρνετε μια νέα και αφού την ανεβάσει την επιλέγετε ώστε να αντικαταστήσει τη ήδη υπάρχουσα
· CONTENT: Το κείμενο που εμφανίζεται κάτω από τον τίτλο
· Στα αριστερά δείχνει όλα τα αντικείμενα που έχουν δημιουργηθεί, μπορείτε να αλλάξετε τη σειρά τους, πιάνοντάς τα με το αριστερό κλικ και το μεταφέρετε σε όποια θέση εσείς επιθυμείτε χωρίς να αφήσετε το αριστερό κλικ. Επίσης μπορείτε να δημιουργήσετε ένα καινούργιο αντικείμενο πατώντας από κάτω το κουμπάκι Add Item, έτσι δημιουργεί ένα άδειο αντικείμενο και το μόνο που έχετε να κάνετε είναι να προσθέσετε έναν τίτλο μία εικόνα και το κείμενο. Και τέλος πατάτε Save & Close

Αντιγραφή και επεξεργασία καινούργιου Gallery Widgetkit 
Αφού έχετε κάνει αντιγραφή του Widgetkit που επιθυμείτε πατάτε στο αντίγραφο που δημιούργησε και μεταφέρεστε μέσα στο Widgetkit. Καλό θα ήταν να μετονομάσετε το Widgetkit με ένα ενδεικτικό όνομα ώστε να σας βοηθήσει μετά στην αναζήτηση. Π.χ. πατήστε copy στο Board of Directors 2018, από κάτω ακριβώς θα δημιουργήσει ένα αντίγραφό του με όνομα Board of Directors 2018 (copy), μπαίνετε μέσα και εκεί που αναγράφει το όνομα Board of Directors 2018 (copy) το σβήνετε και γράφετε Board of Directors 2019
· TITLE: Ο τίτλος σε αυτό το Widgetkit δεν χρησιμοποιείτε, μπορείτε να γράψετε ότι επιθυμείτε ή να το αφήσετε κενό
· Media: Επιλέγετε το κουμπί select και στο παράθυρο που εμφανίστηκε είτε επιλέγετε μια φωτογραφία είτε σέρνετε μια νέα και αφού την ανεβάσει την επιλέγετε ώστε να αντικαταστήσει τη ήδη υπάρχουσα
· CONTENT: Το αφήνετε κενό
· LINK: Το αφήνετε κενό 
· Στα αριστερά δείχνει όλα τα αντικείμενα που έχουν δημιουργηθεί, μπορείτε να αλλάξετε τη σειρά τους, πιάνοντάς τα με το αριστερό κλικ και το μεταφέρετε σε όποια θέση εσείς επιθυμείτε χωρίς να αφήσετε το αριστερό κλικ. Επίσης μπορείτε να δημιουργήσετε ένα καινούργιο αντικείμενο πατώντας από κάτω το κουμπάκι Add Item, έτσι δημιουργεί ένα άδειο αντικείμενο και το μόνο που έχετε να κάνετε είναι να προσθέσετε μία εικόνα. Και τέλος πατάτε Save & Close


Αντιγραφή και επεξεργασία καινούργιου Slideset Widgetkit 
Σε αυτό το Widgetkit δεν θα χρειαστεί να δημιουργήσετε αντίγραφο άλλου slideset ούτε να το επεξεργαστείτε. Υπάρχουν μόνο δύο τέτοια Widgetkit όπως αναφέρετε και παραπάνω και είναι αυτά με id [widgetkit id="1"] είναι για το ελληνικό site και [widgetkit id="39"] για το αγγλικό, το μόνο σημαντικό που χρειάζεται να γνωρίζετε μέσα σε αυτό το Widgetkit είναι το πεδίο Folder Path, αυτό σημαίνει πως μέσα στο site υπάρχει ένας φάκελος images και μέσα σε αυτόν ένας άλλος φάκελος με όνομα Partners-en  και ένας άλλος με όνομα Sponsors αν μπείτε στο id [widgetkit id="1"].
Στην αρχική σελίδα του διαχειριστικού καθώς κάνατε login στο Joomla θα δείτε πως υπάρχει ένα κουτί κάτω από το GREEK HOME PAGE που γράφει «Οι Χορηγοί μας» και ένα άλλο κάτω από το ENGLISH HOME PAGE που γράφει «Our Partners» και από κάτω αναφέρεται ο φάκελος με τις φωτογραφίες που άλλες φωτογραφίες έχει ο φάκελος Sponsors και άλλες ο φάκελος Partners-en διότι κάποια λογότυπα έχουν ελληνικό και αγγλικό κείμενο. Πατώντας λοιπόν στα δύο αυτά κουτάκια μεταφέρεστε στο φάκελο images που αναφέρουμε παραπάνω όπου περιέχει όλους τους φακέλους που θα δείτε και πολλές φωτογραφίες που δεν βρίσκονται μέσα σε κάποιο φάκελο αλλά είναι χύμα στον φάκελο images.
Αν θέλετε να διαγράψετε κάποιο λογότυπο στην Ελληνική έκδοση το μόνο που έχετε να κάνετε είναι να βρείτε τον φάκελο Sponsors και να πατήσετε πάνω του. Στη συνέχεια θα σας εμφανίσει όλες τις φωτογραφίες που είναι μέσα σε αυτόν τον φάκελο εκεί επιλέγετε όποια φωτογραφία θέλετε κλικάροντάς την και αφού εμφανιστεί ένα πράσινο πλαίσιο γύρω από την φωτογραφία και ένα άσπρο Τικ αυτό αυτόματα σημαίνει πως την έχετε επιλέξει οπότε πατάτε το κουμπί Delete που βρίσκετε κάτω από το Menu του Joomla στο πάνω αριστερά μέρος της οθόνης σας και έτσι διαγράφετε μια φωτογραφία. 
Αν θέλετε να προσθέσετε μια καινούργια φωτογραφία πατάτε το πράσινο κουμπί Upload που βρίσκετε κάτω από το Menu του Joomla στο πάνω αριστερά μέρος της οθόνης σας και πάνω από τις εικόνες που απεικονίζονται στο κέντρο της οθόνης σας έχει εμφανιστεί ένα κουμπί Επιλογή αρχείων πατάτε πάνω σε αυτό και αφού επιλέξετε τη φωτογραφία που θέλετε να ανεβάσετε από τα αρχεία του υπολογιστή σας πατάτε το μπλε κουμπί Start Upload και έτσι ανεβάζετε την φωτογραφία.
Τα υπόλοιπα τα κάνει μόνο του Slideset Widgetkit καθώς όπως αναφέρθηκε δείχνει όλες τις φωτογραφίες που είναι μέσα στο φάκελο Sponsors ή Partners-en. 

Modules
Στις εσωτερικές σελίδες και κυρίως στην αρχική σελίδα, υπάρχουν κάποια modules που περιέχουν το κείμενο που εμφανίζεται. Για την επεξεργασία αυτών πηγαίνετε από το μενού στο Extensions->Modules. Καλό θα είναι να μη μπαίνετε σε άλλα modules, πέραν αυτών που είναι διαθέσιμα στην αρχική σελίδα του διαχειριστικού, διότι μπορεί  κατά την επεξεργασία τους να διαγραφεί κατά λάθος κάτι που είναι πολύ σημαντικό για την λειτουργία του site.

Επεξεργασία Slider Αρχικής Σελίδας
Το Slider της αρχικής σελίδας (GR|EN), είναι ένα module. Για την ελληνική version του site το module ονομάζεται Slider Gr, ενώ για την αγγλική Slider En, οπότε μπορείτε να γράψετε στην αναζήτηση τα ονόματα αυτών και έτσι να τα βρείτε πιο γρήγορα. Στη συνέχεια πατάτε πάνω στο Slider που θέλετε να επεξεργαστείτε. Εκεί το Tab, που σας ενδιαφέρει είναι μόνο το HTML Method, σε αυτό το tab βρίσκετε το κείμενο με τις εικόνες και οι ίδιες οι εικόνες ώστε να τις αλλάξετε. Το κείμενο είναι στο πεδίο Image 1 Text και αυτό περιλαμβάνει και το κείμενο της πρώτης εικόνας που απεικονίζεται στον Slider. Με το ποντίκι σας πιάνετε την δεξιά κάτω γωνία του κειμενογράφου που βλέπετε και το τραβάτε προς τα δεξιά ώστε να το επεκτείνετε για να δείτε τα λεκτικά που εμφανίζονται και να τα επεξεργαστείτε. Προσοχή, θα δείτε πως υπάρχουν και κάποιοι περίεργοι χαρακτήρες μέσα στον κειμενογράφο, μην προσπαθήσετε να σβήσετε ή πειράξετε κάτι από αυτούς τους χαρακτήρες, αλλάξτε μόνο το κείμενο που βλέπετε κατά τα υπόλοιπα αφήστε ως έχουν.
H εικόνα είναι στο πεδίο Image 1 Location URL. Για να αλλάξετε την εικόνα πρέπει πρώτα να την ανεβάσετε στον server και μετά να γράψετε την ονομασία της εικόνας που ανεβάσατε με την κατάληξή της (jpg,png,jpeg κλπ.) μετά το πρόθεμα images/ (π.χ images/eepf-2019-anoiksh.jpg)
Θυμίζουμε για να ανεβάσετε εικόνα στον server πάτε από το Menu του Joomla Content->Media, πατάτε στο πράσινο κουμπί Upload που είναι στο πάνω αριστερά μέρος της οθόνης σας, στη μέση της οθόνης πάνω από τους φακέλους, τώρα έχει εμφανιστεί ένα κουμπί Επιλογή αρχείων, πατάτε πάνω του και διαλέγετε την εικόνα από τον υπολογιστή σας, αφού την επιλέξετε και πατήσετε Open, τότε θα κλείσει το αναδυόμενο παράθυρο και τέλος πατάτε το μπλε κουμπί Start Upload. Η φωτογραφία σας ανέβηκε στον server. 
Πιο κάτω θα δείτε και το πεδίο Image 2 Text και Image 2 Location Url πραγματοποιείτε τα ίδια βήματα όπως με την εικόνα 1.

Επόμενη εκδρομή Αρχική
[bookmark: _GoBack]Για να αλλάξετε την ονομασία και την ώρα την επερχόμενης εκδρομής πραγματοποιείτε την εξής διαδικασία:
1) Πατάτε στο εικονίδιο που βρίσκετε στην αρχική σελίδα του διαχειριστικού «Ημ/νια & Ωρα Event [plg_countdownwebidea]»  και αλλάζετε τις ημερομηνίες. Σε περίπτωση σας εμφανιστεί το μήνυμα “You are not permitted to use that link to directly access that page”, κάνετε κλικ απευθείας στο plugin countdownwebidea.
2) Για να αλλάξουμε την ονομασία του event πατάμε στο εικονίδιο της αρχικής σελίδας του διαχειριστικού «Όνομα Επερχόμενου Event» και μας μεταφέρει σε ένα module εκεί το μόνο που αλλάζετε είναι το Title και πατάτε Save & Close.

Επεξεργασία Smart Slider
Το Slider που βρίσκεται στις σελίδες Γαλάζια Σημαία, Green Key, Νέοι Δημοσιογράφοι, Οικολογικά Σχολεία, Μαθαίνω για τα Δάση, Φύση χωρίς σκουπίδια, Πράσινες Γωνίες, Εκπαιδευτικά Προγράμματα, Βύρων Αντίπας είναι Smart Slider. Υπάρχει κουμπί για κάθε slider αυτών των σελίδων στην αρχική σελίδα του διαχειριστικού που σας μεταφέρει στο συγκεκριμένο Slider, όμως μπορείτε να βρείτε και όλα τα Slider από το Menu του Joomla, Components-> Smart Slider, εκεί θα δείτε όλα τα slider που αναφέρονται παραπάνω καθώς και τα δύο καρουζέλ που βρίσκονται στην ελληνική και αγγλική αρχική σελίδα.
Για να επεξεργαστείτε ένα Smart Slider, πατάτε είτε μέσω του κουμπιού της αρχικής σελίδας του διαχειριστικού ώστε να σας μεταφέρει στο συγκεκριμένο slider είναι από το Menu του Joomla, Components-> Smart Slider και μετά στο Slider με την ονομασία που επιθυμείτε. Αφού μπείτε μέσα κάτω από τον τίτλο του slider που αναγράφει θα δείτε τις φωτογραφίες που δείχνει το συγκεκριμένο slider που έχετε μπει. Για να αλλάξετε τις εικόνες κουνάτε τον κέρσορα και τον πάτε στην φωτογραφία που θέλετε να αλλάξετε και εμφανίζεται πάνω από την εικόνα ένα πράσινο κουμπί που λέει EDIT και το κλικάρετε. Στην συνέχεια σας μεταφέρει μέσα στην εικόνα. Στα δεξιά της εικόνας που απεικονίζεται σε μικρή διάσταση θα δείτε τρία κουμπιά Background, Animation, Settings, εσείς πατάτε πάνω στο Background και από κάτω εμφανίζονται κάποιες επιλογές. [image: C:\Users\aris\Desktop\Capture.PNG]
Στην πρώτη επιλογή βρίσκεται η εικόνα που έχουμε ανεβάσει αυτή τη στιγμή για να την αλλάξουμε πατάμε στο πράσινο κουμπί που έχει εικονίδιο μια εικόνα και στη συνέχεια εμφανίζεται ένα νέο παράθυρο με όλες τις φωτογραφίες περιέχει ο server. Στο πρώτο κουτάκι πατάμε εκεί που λέει SELECT FILES ή σέρνουμε τη φωτογραφία μέσα στο πλαίσιο και αφού ανέβει την επιλέγουμε, μόλις την επιλέξουμε αυτόματα αντικαθιστά την παλιά φωτογραφία με την και καινούργια και πατάμε στο πράσινο κουμπί SAVE που είναι στο πάνω δεξιά μέρος της οθόνης μας. Για να γυρίσουμε πίσω στις υπόλοιπες εικόνες του slider πατάμε στο εικονίδιο SLIDES που είναι στο ίδιο ύψος με το πράσινο κουμπί SAVE αλλά είναι στο αριστερό μέρος της οθόνης σας και σας πάει στη σελίδα που απεικονίζει όλες τις εικόνες που περιέχει ο slider. Πραγματοποιείτε ίδια διαδικασία για να αλλάξετε και τις υπόλοιπες εικόνες καθώς επίσης και για τα καρουζελ που είναι στην αρχική σελίδα των ελληνικών και των αγγλικών version. Θα παρατηρήσετε όμως πως υπάρχει και κείμενο στα καρουζελ. Πατώντας στην εικόνα του κσρουζελ και μπαίνοντας μέσα στο κάτω μέρος σας επιτρέπει να αλλάξετε την μικρή εικόνα και τα κείμενο που βρίσκονται από κάτω απλά κλικάροτας σε οποιοδήποτε από αυτά και αλλάζοντας τα.
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